Vision Express User Manual

© 2015 Vision Engraving & Routing Systems

All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the written permission of the publisher.

Products that are referred to in this document may be either trademarks and/or registered trademarks of the respective owners. The publisher and the author make no claim to these trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it. In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.

Revised: 8/19/2015
# Table of Contents

## Part I Introduction

1. Disclaimer and Warranty Information ................................................................. 6
2. Safety Precautions .............................................................................................. 8

## Part II General Information

1. Unpacking and Taking Inventory ..................................................................... 9
2. Machine Description & Terminology ................................................................. 10

## Part III Installation

1. Computer Requirements .................................................................................. 14
2. Machine Connections ....................................................................................... 15
   - Direct Connection to Computer .................................................................... 16
   - Network Connection ..................................................................................... 23
   - Using a Network Hub - ONLY ................................................................. 26
3. Vision Software Installation ............................................................................. 33

## Part IV Step by Step Operation

1. The Front Panel ............................................................................................... 43
2. Holding Down Material ................................................................................... 45
3. Step by Step Operation .................................................................................... 47
4. Diamond Drag Engraving ................................................................................ 47
   - Example Job 1 - Diamond Drag .................................................................... 48
5. Rotary Engraving .............................................................................................. 57
   - Example Job 2 - Rotary Engraving ............................................................... 58
6. Burnishing ....................................................................................................... 62
   - Example Job 3 - Burnishing ......................................................................... 64
7. Profile Cutting .................................................................................................. 72
   - Example Job 4 - Profile Cutting .................................................................... 74
8. Vectorizing Bitmaps and Creating Vector Fills ................................................. 85
   - Vectorizing a Bitmap in Vision Express 9 Software .................................... 85
   - Vector (Hatch) Fills .................................................................................... 87
9. Advanced Operation ......................................................................................... 94
   - Setting and Using Custom Home Positions .................................................. 94
   - Using the Red Dot Laser Pointer for Positioning ........................................ 100
   - Adjusting Spindle Pressure ......................................................................... 106

## Part V Maintenance

1. Cleaning .......................................................................................................... 108
2. Lubrication ....................................................................................................... 109
3. Changing the Motor Belt .................................................................................. 117

© 2015 Vision Engraving & Routing Systems
4 Changing the Motor Brushes............................................................................................................ 119

Part VI Optional Accessories 120
1 Vacuum Chip Removal System....................................................................................................... 120
2 Quick Lock Vise............................................................................................................................. 121
1 Introduction

About This Manual

This manual is designed to provide you with information about your Vision Express engraver. Beginning with unpacking the machine and continuing through installation, operation and lifetime machine maintenance, this manual does not attempt to teach the user how to become an expert in engraving, computer usage, or engraving software usage. Some previous knowledge of engraving terms and the engraving process is certainly beneficial. For information on the Vision Engraving Software, see the Vision Engraving Software manual. For more information on your individual computer system, see your computer’s user manual or contact your computer distributor.

To begin, locate the White/Blue Dongle or Orange Dongle or USB Stick included with your machine in the Accessories Box

Important Note:

The Vision software is available in two versions; one with a dongle, and one that is "dongle-less" and is loaded on to a USB Memory stick.

If your machine was delivered with, or you currently have the white/blue or orange software dongle, DO NOT LOSE IT!

The Vision software will NOT run without the dongle plugged into the computer.
1.1 Disclaimer and Warranty Information

Limits of Liability / Disclaimer of Warranty

The information contained within this manual has been carefully checked and is believed to be accurate, however, Vision makes no representations or warranties for this manual, and assumes no responsibility for inaccuracies, errors, or omissions that may be contained within this manual. In no event shall Vision be liable for any loss of profit including (but not limited to) direct, indirect, special, incidental, consequential, or other damages resulting from any defect or omission in this manual, even if previously advised of the possibility of such damages.

In the interest of continued product development, Vision reserves the right to make improvements to this manual and the products it describes at any time, without notice or obligation.

Limited Warranty:
Vision Computerized Engraving and Routing Systems (and Retrofit Tables)

Vision Computerized Engraving and Routing Systems (Vision) warrants that for a period of one (1) year from the date of shipment to the original purchaser of either a Phoenix, Vision or Table Retrofit (the System), that the System will be free from defects in material and workmanship under normal use and service. Upon written notification, we will transfer the remaining warranty to a new customer. This warranty shall cover all elements except for items covered by separate manufacturer’s warranties and consumable items. “Consumable” items include, but shall not be limited to, belts, brushes, lubricants, and cutters furnished with the System, for which no warranty is provided.

In the event a defect is discovered during the warranty period, within thirty days of discovery, but no later than the last day of the warranty period as described above, the user shall contact Vision for instructions regarding disposition of the problem. Vision shall, at its option, either (1) repair the affected product with new or refurbished parts, or (2) provide a replacement. Any incidental costs, including the cost of shipment from the user’s location to the point of repair and return, and any installation performed by the user, shall be at the expense of the user.

This warranty covers normal use only and shall be void in the event that the System is altered or modified without authorization by Vision, or is subject to abuse, neglect, or other misuse by the user.

The warranties for Third-Party Hardware and Third-Party Software shall run directly from the manufacturers of such hardware and software to the user. Vision makes no warranties, expressed or implied, with regard to Third-Party Hardware or Third-Party Software.
Vision does not warrant any product, component, or part not manufactured by Vision that was not supplied by Vision. (Third-party items, including but not limited to software, are subject to their own manufacturer’s warranties.) Vision does not warrant defects caused by a failure to provide a suitable environment for the system, by unauthorized attachments, by modifications or repairs other than by Vision, by use of the System for other than its original intention, or by other misuse or abuse of the System.

**Extended Warranty**
An Extended Warranty may be purchased which extends the terms of the original equipment Warranty in 1 year increments for a period of up to 30 days after the original equipment Warranty expires. An Extended Warranty may also be purchased for a period of up to 30 days after an existing Extended Warranty expires. Extended Warranties cannot be purchased on any equipment that is 7 or more years old, or if there is a Lapse of Warranty. Age of equipment is determined from the date of shipment to the original buyer.

**Lapse of Warranty**
If an Extended Warranty is not purchased within 30 days of the expiration of the original equipment Warranty, or within 30 days of the expiration of an existing Extended Warranty, the equipment will be in Lapse of Warranty. An Extended Warranty can never again be purchased for any equipment that is in Lapse of Warranty. It is the responsibility of the purchaser of the equipment to maintain accurate records and to know the expiration date of any Warranty.

The above and foregoing is the only warranty of any kind, either expressed or implied, by statute or otherwise, regarding the System, its fitness, quality, merchantability, or otherwise. Any warranties implied by law are hereby expressly disclaimed. No oral or written information or advice given by Vision, its Dealers, Distributors, Agents, or Employees shall create a warranty or in any way increase the scope of this warranty. Neither Vision, nor anyone else who has been involved in the creation, production, or delivery of the System shall be liable for any direct, indirect, consequential, or incidental damages (including damages for loss of business profits, business interruption, loss of business information, and the like) arising out of the use of, or inability to use, the product.

Any software supplied by Vision in conjunction with the purchase of the System for use therewith shall be governed by its own separate software license and warranty agreement.

Terms and Conditions are subject to change

**For Warranty Service Call:** (602) 439-0700
Please have your machine serial number ready before calling.

Vision Engraving & Routing Systems is owned and operated by Western Engraver’s Supply, Inc. Phoenix, Arizona, USA
1.2 Safety Precautions

Ø Keep hands clear of the bottom of the spindle during operation.
Ø Always stop the machine before making any adjustments.
Ø Do not operate the machine with the covers removed.
Ø Wear safety glasses when cutting any materials that emit chips.
Ø Use extreme caution when inserting or removing cutters.
Ø Before any servicing, disconnect the power cord.
Ø To avoid electric shock or equipment damage, ensure that the machine is connected to the appropriate electrical source as noted in the installation procedures.
Ø Never operate the equipment with damaged or frayed power cords, loose connections, or exposed extension cords where someone can walk on the cord and create a tripping hazard.
Ø Be sure to hold the plug, not the cord, when disconnecting the machine from a power source.
Ø Place the machine in a location with low humidity and a minimum of dust. Follow the maintenance instructions for proper cleaning of the machine's air filter.
Ø If your machine does not operate properly; in particular, if there are any unusual sounds or smells coming from it, immediately unplug it and contact Vision's service department or your local distributor.
Ø Unplug the machine when it is going to be left unused for an extended period of time.
2 General Information

2.1 Unpacking and Taking Inventory

The Vision Express engraving system has been shipped in one carton, unless other accessories have been ordered with the machine that will not fit in the box. Examine the condition of the box for external damage. In the event of apparent external damage, notify your shipping carrier upon receipt, and call your sales representative or Vision immediately.

Note: The shipping container is considered reusable and should be stored for use in the event of service need or upgrade.

Step 1:
Open the foam packed shipping carton. In the top of the carton will be a cardboard box with all of the machine accessories (including this manual). The following items should be included:

- 1 Vision Express Machine
- 1 Vision Express Warranty Card
- 1 Vision Express Installation Guide
- 1 White/Blue or Orange USB security dongle - Contains User Manual and Vision Software
- 1 Ethernet Network Cable
- 1 Crossover Cable
- 1 Power Cord
- 1 External Power Supply
- 1 0.015 FLX Plastic Cutter
- 1 Diamond Drag Cutter
- 1 6 x 8 inch Multi Mat Material
- 1 Spare Motor Belt
- 1 Allen Wrench Set
- 1 Cutter Wrench
- 1 Technical Support Label
- 1 Delivery and Sign-off Sheet
- 1 Accessory Sheet

Check to see that all of the items are included. Should any of the contents be missing, damaged, or of the incorrect type, please call your sales representative or Vision immediately.

Step 2:
Prepare a clean, level surface to put the engraving machine on. Carefully lift the machine out of the carton and place it on the table.

Step 3:
After unpacking the machine, make sure that you SAVE THE CARTON, FOAM PACK and ANY OTHER BOXES. They can be reused in the event the system must be transported to another location or returned for service. Improper packaging for shipment can damage the machine and may void the warranty.
Machine Description & Terminology

This chapter briefly describes the major components of the Vision Express engraver and will help you identify the parts of your engraver which are discussed elsewhere in this manual.

**SPECIFICATIONS:**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z-Axis Clearance:</td>
<td>1.25 inch (31.75 mm)</td>
</tr>
<tr>
<td>(Definition: the distance between the bottom of the spindle and the work surface)</td>
<td></td>
</tr>
<tr>
<td>Z-Axis Stroke:</td>
<td>1.25 inch (31.75 mm)</td>
</tr>
<tr>
<td>(Definition: the travel distance of the Z-axis mechanism or spindle)</td>
<td></td>
</tr>
<tr>
<td>Table Resolution:</td>
<td>.0002 inch</td>
</tr>
<tr>
<td>(Definition: the smallest controlled motion the table is capable of)</td>
<td></td>
</tr>
<tr>
<td>Maximum Speed:</td>
<td>3 inches per second (76.2 mm/s)</td>
</tr>
<tr>
<td>Spindle Type:</td>
<td>11/64 inch (4.366 mm) top load</td>
</tr>
<tr>
<td>Maximum Work Area:</td>
<td>6 inch x 8 inch (152.4 mm x 203.2 mm)</td>
</tr>
<tr>
<td>Maximum Work Piece Size</td>
<td>8 inch (203.2 mm) x Unlimited</td>
</tr>
<tr>
<td>Overall Dimensions H x W x D:</td>
<td>9.5 inch x 17.5 inch x 17.5 inch (241.3 mm x 444.5 mm x 444.5 mm)</td>
</tr>
<tr>
<td>Table Top:</td>
<td>T-Slot</td>
</tr>
<tr>
<td>Interface:</td>
<td>Ethernet</td>
</tr>
<tr>
<td>Controller:</td>
<td>Embedded</td>
</tr>
<tr>
<td>Power Requirements:</td>
<td>110 - 220 VAC</td>
</tr>
<tr>
<td>Shipping Weight:</td>
<td>TBD</td>
</tr>
<tr>
<td>Shipping Dimensions:</td>
<td>TBD</td>
</tr>
</tbody>
</table>
DEFINITION OF TERMS (see Figures below)

1. **Front Panel** - Allows the user to start, pause, and resume operation. A green LED indicator signals when the machine is ready, if a job has been loaded or if a job has completed. For details on the indicator light, see the Operation section.

2. **Emergency Stop** - A push button emergency shut down of the motion system (does not turn machine completely off, just stops motion).

![Top View](image1.png) ![Emergency Stop](image2.png)

3. **X-Axis Leadscrew** - The screw that drives the left to right motion of the machine.

4. **X-Axis Linear Rail** - The 9/16" square rail that the carriage assembly rides on.

5. **Y-Axis Linear Rail** - The 9/16" square rail that the t-slot table rides on.

6. **Y-Axis Leadscrew** - The screw that drives the front to back motion of the machine.

7. **T-Slot Table (work surface)** - Allows the user to position the engraving material or special clamps and fixtures. The slots in the table are shaped with an upside-down T. The slots are used to hold various accessory holders, clamps, and jigs.

8. **Table Home Position** - The upper-left corner of the T-Slot table. All work is referenced from this position.

9. **Spindle Cover** - Protects user from rotating spindle during operation.
10. **Spindle** - Holds various cutters and allows for cut depth adjustments.

11. **Motor Belt** - Supplies rotary motion to the spindle.

12. **Spindle Motor Pulley (not shown)** - Behind the spindle, and attached via the motor belt, the motor pulley drives the spindle rotation when rotary engraving or cutting. (The spindle motor pulley is hidden by two covers).

13. **Spindle Pulley** - The top part of the spindle where the motor belt rides.

14. **Spindle Micrometer** - The part of the spindle that the user adjusts to set engraving depth.

15. **Spindle Nose Cone** - The part of the spindle that rides on top of the material while engraving. Cutting depth is determined by the distance the cutting tool extends below the bottom of the nose cone.

Figure 1.3

Figure 1.4
3 Installation

In the following sections, the complete machine and Vision software installation will be outlined. There are three connection configurations possible with the Vision Express.

The first is a direct cable connection from the Vision Express to your computer via the network port. There is a special "crossover" cable supplied with the machine for this connection type. This configuration is for a stand alone computer that is NOT connected to a WIRED network or internet. The machine can be connected to a computer that is connected to a wireless network in this manner.

The second configuration is for connection to the Vision Express through a wired network using a standard network cable (DO NOT use the crossover cable when connecting to a network). In this configuration, the Vision Express will be recognized as a network device. Connection to the machine in this manner is the easier of the two connection types. If there are no network connections available, a network hub can be added to allow connection of the Vision Express to your network.

The third configuration is for a connection from the computer to a hub (or router) and then to the Vision Express. This is WITHOUT a computer network. Standard Ethernet cables are used in this configuration.

Please call your distributor or the service department at Vision for assistance if you are having problems connecting your machine.

**IT IS HIGHLY RECOMMENDED THAT THE COMPUTER USED TO OPERATE THE VISION ENGRAVER OR ROUTER BE CONNECTED TO THE INTERNET. THIS ALLOWS THE USER TO ALLOW VISION'S TECHNICAL SUPPORT TO ACCESS THE MACHINE AND TROUBLESHOOT IF NECESSARY.**
3.1 Computer Requirements

Minimum System Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Dual Core (2.0GHz or higher)</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>500 GB free space</td>
</tr>
<tr>
<td>RAM</td>
<td>1GB + OS Requirements</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 10 - 32 Bit &amp; 64 Bit</td>
</tr>
<tr>
<td></td>
<td>Windows 8 &amp; 8.1 - 32 Bit &amp; 64 Bit</td>
</tr>
<tr>
<td></td>
<td>Windows 7 - 32 Bit &amp; 64 Bit</td>
</tr>
<tr>
<td></td>
<td>Windows XP SP3 - 32 Bit (64 Bit not supported)</td>
</tr>
<tr>
<td>Ports</td>
<td>USB port for security dongle</td>
</tr>
<tr>
<td></td>
<td>Local or network Ethernet port to connect machine</td>
</tr>
</tbody>
</table>

Suggested System Requirements

<table>
<thead>
<tr>
<th>Component</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Core i3 (or faster)</td>
</tr>
<tr>
<td>Hard Drive</td>
<td>1 TB (or more)</td>
</tr>
<tr>
<td>RAM</td>
<td>4GB + OS Requirements</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows 10 - 32 Bit &amp; 64 Bit</td>
</tr>
<tr>
<td></td>
<td>Windows 8 &amp; 8.1 - 32 Bit &amp; 64 Bit</td>
</tr>
<tr>
<td></td>
<td>Windows 7 - 32 Bit &amp; 64 Bit</td>
</tr>
<tr>
<td>Ports</td>
<td>USB port for security dongle</td>
</tr>
<tr>
<td></td>
<td>Local or network Ethernet port to connect machine</td>
</tr>
</tbody>
</table>
3.2 Machine Connections

On the rear of the Vision Express, there are three connection ports. The power cord, the network cable (or crossover cable) RJ-45 ethernet port, and the remote on/off port for optional equipment.

Vision Express (rear view)

Connect the power supply cord to a 110 - 220 VAC source, then plug the power cable into the port on the back of the machine. Plug in the network cable (or the crossover cable) to the back of the machine and either plug the network cable into your network, your hub, or using the crossover cable, plug into the network port on the back of your computer.

NOTE - The crossover cable is colored gray.
3.2.1 Direct Connection to Computer

Direct Connection to Computer Using Crossover Cable

Once the machine is connected directly to your computer's network port with the crossover cable (the gray colored cable), turn the machine on. The power switch for the Vision Express is located on the power supply box for the machine. Once the machine has initialized (an audible “bump” will indicate that initialization is complete), plug the supplied Vision USB drive into an available USB port on your computer.

NOTE - This installation is performed on a Windows 7 PC. For Windows XP, Windows 8, Windows 8.1 or Windows 10, the screens are slightly different.

The computer will recognize the USB drive and the following screen will appear. Select Continue without scanning.

Select Open folder to view files.
Locate the file named Start and double click on the file to start the installation. The screen below shows Start.exe, but your computer might not show the .exe portion.

Select Step 1 - Setup Machine. This installs the Vision Connectivity Manager software.
When the software is installed, select Finish.

The Connectivity Manager will search for available Vision devices.
The computer's IP address will need to be set. NOTE - this should not cause any conflicts with your computer's wireless IP address, which is determined by the computer's wireless network card. To set the computer's IP address, open the Window's Control Panel. Depending on how you have this folder set, you will either see Network and Internet, or you will see the Network and Sharing Center immediately. If you see Network and Internet, select View Network Status and Tasks (which opens the Network and Sharing Center). If you see the Network and Sharing Center, open it. Then select Local Area Connection (as shown below).

Select Properties.

Then select Properties. Select Use the following IP address: and enter 192.168.5.100 as shown. Then click in the Subnet Mask area, which will populate the correct location of 255.255.255.0, then select OK and close any other network configuration windows.
The IP address of the machine will need to be set to set up the connections properly. Select the + box next to the machine now listed in the window to expand the information. Then select Configure Vision Express Engraver at the bottom of the screen.

Select Use Static IP.
Set the IP address (as shown) to 192.168.5.101, then select OK. This sets the machine's IP address.

The configuration is complete at this point. Close the Machine Tools Discovery window and return to the Main Installation Screen to proceed with the Vision software installation in the next section.
3.2.2 Network Connection

Connecting via Standard Network Cable to Network

Once the machine is connected to your network, turn the machine on. The power switch for the Vision Express is located on the power supply box for the machine. Once the machine has initialized (an audible “bump” will indicate that initialization is complete), plug the supplied Vision USB drive into an available USB port on your computer.

NOTE - This installation is performed on a Windows 7 PC. For Windows XP, Windows 8, Windows 8.1 or Windows 10, the screens are slightly different.

The computer will recognize the USB drive and the following screen will appear. Select Continue without scanning.

Select Open folder to view files.
Locate the file named Start and double click on the file to start the installation. The screen below shows Start.exe, but your computer might not show the .exe portion.

Select Step 1 - Setup Machine. This installs the Vision Connectivity Manager software.
When the software is installed, select Finish.

The Connectivity Manager will search for available Vision devices.

The configuration is complete at this point. Close the Machine Tools Discovery window and return to the Main Installation Screen to proceed with the Vision software installation in the next section.
3.2.3 Using a Network Hub - ONLY

Connection from PC to Hub or Router to Machine or Controller

Once the machine is connected to a hub or router, and the hub or router is connected to your computer’s network port, turn the machine on. The power switch for the Vision Express is located on the power supply box for the machine. Once the machine has initialized (an audible "bump" will indicate that initialization is complete), plug the supplied Vision USB drive into an available USB port on your computer.

NOTE - This installation is performed on a Windows 7 PC. For Windows XP, Windows 8, Windows 8.1 or Windows 10, the screens are slightly different.

The computer will recognize the USB drive and the following screen will appear. Select Continue without scanning.

Select Open folder to view files.
Locate the file named Start and double click on the file to start the installation. The screen below shows Start.exe, but your computer might not show the .exe portion.

Select Step 1 - Setup Machine. This installs the Vision Connectivity Manager software.
When the software is installed, select Finish.

The Connectivity Manager will search for available Vision devices.
The computer's IP address will need to be set. To set the computer's IP address, open the Window's Control Panel. Depending on how you have this folder set, you will either see Network and Internet, or you will see the Network and Sharing Center immediately. If you see Network and Internet, select View Network Status and Tasks (which opens the Network and Sharing Center). If you see the Network and Sharing Center, open it. Then select Local Area Connection (as shown below).

Select Properties.

Then select Properties. Select Use the following IP address: and enter 192.168.5.100 and set the Subnet mask to 255.255.255.0 as shown. Then select OK and close any other network configuration windows.
The IP address of the machine will need to be set to set up the connections properly. Select the + box next to the machine now listed in the Discover Machine Tools window to expand the information. Then select Configure (Your Machine) at the bottom of the screen.

Select Use Static IP.
Set the IP address (as shown) to 192.168.5.101, then select OK. This sets the machine's IP address.

The configuration is complete at this point. The new IP address should appear in a few seconds in the Discover Machine Tools window. Close the Discover Machine Tools window and return to the Main Installation Screen to proceed with the Vision software installation in the next section.
3.3 Vision Software Installation

From the Main Installation Screen, Select Step 2 - Install Vision Software.

The Windows Installer will prepare the installation.

Select Next.
Select Install.

The installation will proceed.

Select the appropriate language and select OK.
Installation will proceed.

Select Next to begin the installer.

Select Accept the license agreement, then select Next.
Select Next (or change the destination folder - not recommended).

Select Next to create the folder.
The installation will continue.

Select the Vision Express by placing a check mark in the box to the left of Vision Express in the Manufacturer list on the left side of the page, then select Next. Note - this is the default for Vision Express software after installing the Connectivity Manager in the previous section. If you purchase another engraving system from Vision, it can be added to the machine list at a later date from within the Vision software.
Select Continue to install True Type fonts and Vision Engraving Fonts on your computer.

The software will look for True Type fonts on your computer and allow the Vision software to use them.

Once the True Type fonts are installed, select OK.
In this step, the software will install any Engraving fonts on your computer.

When complete, click on OK.

In order to install the fonts on the USB drive, select A Removable drive and from the drop down list, select the drive letter for the USB drive plugged into your computer.
Select OK to install to the default folder.

Select OK. All fonts and clipart have been installed from the USB drive at this time.

Select OK to return to the main installation screen.
To complete the installation, select Finish.

To close the Software Setup window, select Finish.
Select Exit to close the installer.

The Vision manuals icon should now appear on your computer's desktop along with an icon for your version of Vision 9 software.

Clicking on the Vision manuals link will give the user access to User Manuals, Installation Guides, Accessories and Training Videos.

If you were supplied with an Orange Dongle (orange USB stick), keep it installed in your computer's USB port in order to use the Vision software. If you were supplied with another color USB stick with your machine, it can be removed at this time from your computer. Installation is now complete.
4 Step by Step Operation

4.1 The Front Panel

The front panel of the engraver is shown below. In order to maintain simplicity of operation, the majority of the machine's settings and controls are through the Vision software interface. The front panel has buttons for Start, Pause and on top of the machine is the Emergency Stop button.

There are two green LED indicator lights on the front panel. The top indicator light will appear when the machine's power switch (located on the power supply) is turned on. The second indicator light is above the Start Button.
The indicator light above the Start Button indicates the status of the machine with the following:

**Flashes Twice** - Ready Status - When the machine is first powered up, after approximately 10 - 15 seconds, the drive motors will receive a power up signal from the processor and you may hear a very light "bump" as they receive power. The Start Button Indicator light will repeat a pattern of flashing twice. The machine is ready to receive a file.

**Steady Flashing** - File Ready to Engrave - If the Start Button Indicator Light flashes at a slow, steady rate, a file is ready to run.

**Rapid Flashing** - Emergency Stop Depressed - If the Start Button Indicator Light rapidly flashes, the Emergency Stop Button has been depressed. If the Emergency Stop was pressed to prevent the machine from continuing operation (if there was a problem with material of file setup), after resolving the problem, turn the Emergency Stop Button clockwise (as viewed from the top of the machine) to release the stop button. To move the motion system to the home position, press the Pause Button. To recall the last job sent, press the Start Button, then press Start again to begin engraving.

**Light OFF** - File Complete - After running the file, the Start Button Indicator Light will turn off.

**HINT** - if the user wishes to re-run the last completed file, press the Start Button to re-call the last file and the indicator light will begin steady flashing. Press the Start Button to run the file. If the machine was powered off, all files are erased and pressing the Start Button will not recall any files.

**Flashes Three Times** - This indicates that a file has been Paused. If the user presses the Start Button, the file will resume from the position where it was paused. If the Pause Button is pressed again, the machine will return to the home position. To re-call the last file, press the Start Button once. To re-run the last file, press the Start Button again.

**Re-Home Function**

In order to verify or Re-Home the Express engraver - 1) If no files have been sent to the engraver, press the Pause Button, or 2) If a file has been sent to the engraver, press the Pause Button once, then press and hold the Pause Button. After re-homing the engraver, the status light will turn off.
4.2 Holding Down Material

There are many ways to hold material down on the t-slot table. One of the easiest things to do is to place the material in the upper left corner of the t-slot table. This will ensure that the engraving is in the correct position on your material.

You can use double-sided tape, Multi Mat hold down material, or the quick lock vise to hold down material to the t-slot table. Double-sided tape or Multi Mat material are available from your Vision Distributor or directly from Vision. The quick lock vise is an optional accessory for the Vision Express - see the Optional Accessories section for details.

Hold Down Techniques

Holding material in place is critical for engraving and cutting applications. The Multi Mat material is useful for both applications, but using double-sided tape or a spray adhesive can be a better choice for some applications. For most materials and engraving applications, the Multi Mat material is the easiest to use. Simply place it on the table and place the material to be engraved on top of it. When cutting completely through, or kiss-cutting materials, care must be taken to not cut too far through the material, or the Multi Mat will be slightly cut in the process. The most common approach to cutting when using the Multi Mat is to set the cut depth using the machines micrometer or the "stacked material method" as described below and in the section on Profile Cutting. When using the micrometer, the material thickness should be measured with calipers. Keep in mind that some materials can vary in thickness and there may be areas that remain uncut. For a detailed explanation on the use of the micrometer for setting cutting depth, see Example Job 4 in the Profile Cutting section.

Using Sacrificial Material

Many times, double sided tape can be a quick and very secure way to hold material down the the t-slot table. The downside to using tape is that it will remain on the table and can be a problem to remove. A better solution is to place Multi Mat material on the t-slot table, then place a piece of sacrificial material (of the same type as being cut) on top of the Multi Mat. Then apply double-sided tape to the sacrificial material and place the material to be cut on top of the sacrificial material. In this manner, while the machine is engraving or cutting other jobs, the sacrificial material/cut material can be removed and separated by the user, making better use of machine time and allowing for easier clean up. Note - if double-sided tape is used, be careful to cover a sufficient area to keep the material in place and also to hold smaller pieces in place so they to not move when the last section of the small piece is cut.

Spray Adhesives

Using a spray adhesive, in conjunction with "transfer tape" or "application tape" is yet another method often used. As with the other methods, place Multi Mat on the t-slot table. A piece of sacrificial material is then covered with transfer tape on its top surface and a spray adhesive is applied on top of the tape. Place the sacrificial material with the tape/adhesive side facing up on the Multi Mat material. Then, the material to be cut should have transfer tape applied to its back side and adhesive is sprayed on to the transfer tape. Place the material to be cut, tape/adhesive side down, on to the sacrificial material. This is a very secure way to cut through materials and once cutting is finished, the tape/adhesive can be easily removed from the back sides of cut pieces.
**Edge Guides:** The t-slot table edge guides need to be adjusted to the thickness of material that you are engraving. If they are not adjusted properly, the machine may not engrave characters completely.

### Edge Guides (Side View)

To adjust the edge guides, loosen the edge guide thumbscrews and raise the edge guides to their top position, then lightly tighten the thumbscrews. Slide the material you would like to engrave up against the top and left sides of the t-slot table - the edge guides will stop the material. Loosen the edge guide thumbscrews and lower the edge guides until they are even with the material surface, or just below the material surface. Tighten the edge guide thumbscrews. This process should be repeated anytime materials of different thicknesses are to be engraved. On thicker materials, more than 0.10 inch (2.5 mm), the edge guides can remain in their uppermost position.
4.3 Step by Step Operation

In the following sections, there are 4 example jobs the user can use to learn the different ways to use the Vision Express. In the first section, the machine will be set up to perform a diamond drag operation on coated aluminum and a simple plate will be engraved. In the second example, engravers plastic will be rotary engraved to make a small sign. The third example is a coated brass burnishing operation which will cover the importing of text variables for multi-plate engraving. In the last example job, a set of name badges will be engraved and cut out of engravers plastic.

The sections and example jobs are designed to incrementally teach the user how to use the machine, as well as use some of the common functions within the Vision software. It is recommended that the first time user read through and practice the techniques in these example files in the sequence they are provided in this manual.

4.4 Diamond Drag Engraving

Engraving - Non Rotating

In this section, we will set up to engrave with a non-rotating cutter, such as a diamond drag cutter. The figure below shows the Vision Express spindle with a diamond drag cutter.

The Vision Express spindle with diamond drag cutter

First, to install the diamond drag cutter, loosen the set screw on the cutter knob with the supplied cutter wrench and move the cutter knob to about the mid-point of the cutter tool, then lightly tighten the set screw. (Note that the set screw on the cutter knob is NOT a standard Allen screw. It is a Spline Wrench. DO NOT attempt to turn the set screw with any tool other than the cutter wrench). Insert the cutter into the top of spindle and lower it until the cutter knob can be screwed into the spindle. The cutter knob is REVERSE threaded, so in order to tighten the cutter knob, turn the knob COUNTER-CLOCKWISE (when viewed from the top of the spindle) until it is hand tight.
With your finger at the bottom of the nose cone, loosen the cutter knob set screw and lower the cutter so that the cutting tip extends below the bottom of the nose cone by approximately 1/4 inch (6 mm). Then tighten the cutter knob set screw.

Turn the engraver on by flipping the switch on the power supply. Set up the job you would like to engrave in the Vision Software (for an example job, please refer to the following section). Place the material on the t-slot table as described in the previous section. There is no need to adjust the Z-Axis height of the machine (also known as Set Surface). In this type of engraving, the Proximity Sensor will automatically sense when the cutter tip contacts the material and will adjust the Z-Axis height and cutting pressure. Also, the spindle does not need to rotate. The material selection (shown in the next section) will preset the engraver to turn the spindle rotation off and turn the proximity sensor on.

### 4.4.1 Example Job 1 - Diamond Drag

In this first example, Diamond Drag engraving will be performed on a 3" x 2" plate. The material used for this example application is black painted aluminum.

Starting with a new file in Vision Express software, the first step is to adjust the plate size to match the plate to be engraved.

Click on the Plate Size icon.
The Plate Size window will appear with either the last plate size used, or the default size for the Vision Express engraver.

Click on the Current Selection drop down list and select Custom.
Enter the plate size to be engraved - for this example 3" x 2".

To add text, click on the Text Tools icon.

The flyout icons will appear, then select the Text Compose icon.
Click somewhere in the drawing to begin typing text. Note that on the top toolbar, the various font editing fields have appeared. The user should become familiar with the various ways fonts can be formatted with the toolbar options. For this example, the only change was for the font height, which was set to 0.500".

Begin typing text to be engraved.
In order to align the text to the center of the plate, select Layout ➔ Arrange and Distribute ➔ Align to Sign Blank ➔ Center (as shown below) from the top toolbar. Note that there are several ways to align objects within the Vision software.

The Break Text warning may appear. If so, select No. If Yes is chosen, and more than one line of text has been entered, each line will align on top of one another in the center of the plate.

At this point, the screen should appear as below.
Next, the material should be placed on the engraving table, with the upper left corner of the material positioned in the home position (upper left corner of the engraving table). Note that the Multi Mat material has been placed on the t-slot table in order to hold the engraving material in place.

Select the Engrave icon from the left toolbar.

The Cut Toolbox will appear and the options for engraving will appear on the top toolbar. Make sure the Device selected is for your machine, then select the Tool Setup icon.
The Tool Setup window will appear. Select the appropriate material from the Material Selection drop down list. In this example, the material - Metals(Diamond Drag) is selected. Then click on OK.

Since we are running a file for the first time, we will select the Dry Run option from the Cut Toolbox.

Make sure the "D" appears by selecting it. The default is "Off" for the Dry Run, which will engrave the plate. We want to make sure our file has been set up properly in this example and that the material is positioned correctly.

**NOTE - Dry Run Operation** - There is an offset between the spindle and the red laser pointer of approximately 0.38 inches (9.6 mm) in the X and 0.44 inches (11.2 mm) in the Y directions. Therefore, if the characters to be engraved extend beyond 7.56 inches (192 mm) X (to the right) and 5.62 inches (142.7 mm) Y (toward the bottom) of the machine's home position, the file will not run because the spindle would have to move beyond its limits.

When ready to send the file to the engraver, make sure the engraver's power switch is turned on and the machine has initialized, then select the Engrave icon from the Cut Toolbox.
Note - keeps hands and other loose objects away from the engraver during operation.

Press the Start Button on the engraver to begin the Dry Run. The Dry Run feature will automatically activate the red dot laser pointer and show the user where the machine will engrave.

Note - If the spindle turns, or begins to drop toward the material, either press the Pause Button or the Emergency Stop Button on the engraver. If either of these occur, make sure that Dry Run was selected in the Cut Toolbox (shown as the letter "D") and that the spindle has not been turned on. The Spindle icon on the Cut Toolbox is show below for reference.

Spindle icon (shown as disabled)

Red Laser Pointer

Red Laser Pointer Located Up and To The Left of Spindle Centerline
If the file and material appear to be positioned properly and you are ready to engrave, select the Engrave icon from the left toolbar, turn off the Dry Run option and check to make sure the Proximity Sensor (see the Prox icon below) is enabled, then select the Engrave icon on the Cut Toolbox to send the file to the engraver.

Make sure the material is positioned properly and secured on the engraving table, then press the Start Button on the engraver to begin engraving.

The finished piece should appear as shown below.
4.5 Rotary Engraving

In this section, we will set up to engrave with a rotating cutter. The figure below shows the Vision Express spindle with a rotary cutter.

Vision Express Spindle with Rotary Cutter

First, to install the rotating cutter, loosen the set screw on the cutter knob with the supplied cutter wrench and move the cutter knob to about the mid-point of the cutter tool, then lightly tighten the set screw. (Note that the set screw on the cutter knob is NOT a standard Allen screw. It is a Spline Wrench. DO NOT attempt to turn the set screw with any tool other than the cutter wrench). Insert the cutter into the top of spindle and lower it until the cutter knob can be screwed into the spindle. The cutter knob is REVERSE threaded, so in order to tighten the cutter knob, turn the knob COUNTER-CLOCKWISE (when viewed from the top of the spindle) until it is hand tight. Then, you must zero the cutter. To do this, you must first turn the micrometer so that the pointer points to 0. Note - it is helpful to first turn the micrometer to the left (clockwise) until threads just start to appear on the spindle. This will be about 3 - 4 full turns of the micrometer from its uppermost position. This allows for sufficient depth adjustment when turning the micrometer to the right.

With the machine powered off, take a scrap piece of material and push it up underneath the nose cone and hold it there. Loosen the cutter knob set screw and push the cutter down until it just touches the material. Tighten the cutter knob set screw. The cutter is now zeroed.

To run a job, turn the machine on by flipping the switch on the power supply, then set up the job in the Vision Software. (For more information on this, see the Vision Engraving Software manual and the example job file in the next section). Put the material on the t-slot table as described in the previous section.

Adjusting Depth of Cut

Cutting depth depends on the type of material being engraved. Generally, manufacturer's of engraving plastic provide recommendations for cut depth. If a recommended depth is unavailable, trial and error can be used to find the appropriate cut depth. Since the depth is set to zero at this time, in order to increase cut depth, the micrometer at the bottom of the spindle should be rotated to the right (counter-clockwise when viewing from the top of the spindle). To set a depth of 0.010 inches (0.25 mm) turn the micrometer to the right 10 clicks. Each "click" of the micrometer is 0.001 inches (0.025 mm). Run a job with an initial setting of 0.005 - 0.010 inches (0.12 - 0.25 mm). After the job has run for a short time, press the Pause Button on the front panel, then adjust the micrometer for more or less depth,
depending on the whether the engraving is acceptable. Note - be careful not to set the depth of cut greater than the material thickness. This will cut completely through the material and potentially cut into the t-slot table.

For a detailed example of running an rotary engraving job, please see the following section.

4.5.1 Example Job 2 - Rotary Engraving

In this example, a sign will be made using engraver's plastic. The piece is pre-cut and measures 4 inches x 6 inches (100 x 150 mm).

Note - In this application, it is highly recommended to use the Vacuum Chip Removal System as described in the Optional Accessories section. The process of engraving or cutting plastics, acrylics, sign foam and wood, produces a significant amount of debris that can clog the nose cone and/or get trapped between the nose cone and the material, which will cause engraving/cutting depth inconsistencies as well as potentially scratch the surface of the material. The Vacuum Chip Removal System significantly reduces these problems and provides for a cleaner work area.

As with Example Job 1, the first step is to set the plate size in the Vision Express software.
Then, we will enter the text using the Frame Text Compose tool as shown below.

With this tool selected, text will automatically be centered and have automatic Kerning. In the below example, the font was changed to Casual1, with a height of 1.250 inches and a slant of 19 degrees. The top and center lines are left justified and the bottom is center justified in order to produce a sloping look to the sign. All of these adjustments are available when entering text in the Frame Text Compose mode.
Once the file has been set up, select the Engrave Icon from the left toolbar, click on the Tool Setup icon and from the Materials selection drop down list, select Engravers Plastic(Engraving), then click on OK.

In the picture below, the Cut Toolbox shows that the Vacuum, Prox, Dry Run, and Spindle are all enabled. Since this is the second example job, sending a Dry Run job to the engraver is suggested. Select the Engrave Icon to send the file to the engraver.

If the Dry Run showed no set up errors, the job can be re-sent to the engraver with the Dry Run disabled.

Place the material on the table (shown with Multi Mat on the t-slot table to hold the engraving material in place), and press the start button on the machine to begin engraving.
NOTE - The design of the Vacuum Chip Removal System is to clear the debris away from the engraved material and prevent the chips from scratching the surface of the material during operation, and/or getting trapped between the nose cone and the material (when using the proximity sensor function) and causing the engraver to not engrave to the proper depth.

When the file is complete, remove the material from the table. HINT - Use a light bristle brush to clean out any debris that may remain in the engraved characters.
4.6 Burnishing

In this section, we will set up to engrave with a burnishing cutter. The figure below shows the Vision Express spindle with a burnishing cutter and an optional EZ Rider burnishing adapter.

The Vision Express spindle with burnishing cutter

Burnishing is different than standard rotary engraving mainly because the nose cone is not used to set the depth of cut. Burnishing does not actually cut deep into metals, rather it cuts the painted surface off of metals. To effectively burnish, it is recommended to use an optional EZ Rider burnishing adapter. This helps to control the pressure of the cutter applied to the material. Burnishing requires less pressure than other types of engraving and the EZ Rider attachment applies the proper amount of pressure for burnishing.

Installing the EZ Rider is similar to using a cutter knob. First, screw the EZ Rider into the top of the spindle hand tight. Next, insert the cutter through the EZ Rider and spindle so that the cutter sticks out below the nose cone approximately 1/4 inch (6 mm). Tighten the set screw in the EZ Rider to hold the cutter in place.

In order to set the engraver up for burnishing, we will need to perform a "Set Surface" function. Open up the Vision Engraving software and select the Jogger icon.
Select Connect to enable communication with the engraver, then click on the move arrows to move the cutter over the material that was placed on the t-slot table. Lower the cutter/spindle with the Z Down button until the tip of the burnishing cutter comes in contact with the material. Once the burnishing cutter just touches the material, move the Z Down approximately 0.03 - 0.05 inches (0.5 - 1.0 mm) to preload the EZ Rider spring. Select the Set Surface button in the Jogger window to set this as the Z position on the engraver. Once the surface has been set, select Go to Home, select Disconnect and close the Jogger Window.

In the following example job, a burnishing file will be set up and run on coated brass material.
4.6.1 Example Job 3 - Burnishing

In this example, another feature in the Vision Software will be introduced. We will create a Plate Object in order to create multiple items with different text engraved on a single 8 x 6 inch (203 x 152 mm) piece of coated brass (also known as black brass or trophy brass). The plate will use a text import function from an external text file that will be copied into a plate template and the Vision software will automatically format the imported text.

Begin by selecting the Plate Size Icon and setting the engraving area to the standard Vision Express 8 x 6 inch area.

To create the Plate Object, select Layout → Plate Object → Create Plate from the top toolbar menu.
Adjust the number of plates to 1, leave spacing at 0.000 inches, width and height to 2.500 and 1.25 inches, set the page margins to 0.250 inches as shown, then click on Apply. Note that the page margins on the toolbar are located such that the top field is for the top margin, the left field is the left margin, etc.

The screen should then appear as below.

Select the Text Compose Icon.
Click in the middle of the Plate Object.

Enter any text in the format you wish to use. In this example, two lines of text are entered as variables (it does not matter what you type. The text entered is only for formatting and will be replaced with the text imported from the .txt file).
Each line of text can be independently set for font and size. Highlight the text to be changed, then from the font list on the top toolbar, choose the font to be used for the selected text and double click on the font name. If the size or other parameters need to be revised, use the toolbar fields to modify the font style. Please note that in this example, the Width Compression for the text was adjusted. In order to adjust the Width Compression, select the text, click on the Toolbar Mode icon (shown below).

Select Frame mode.

Select all text and select the Width Compression Mode by clicking on the drop down list (as shown).
Change the settings to Always compress or expand text to fit width, Method: Width compress/expand, and Apply to: Each Line Individually. Deselect Word Wrap, then select OK.

For a detailed description of all the font modifications possible, refer to the Vision software help or user manual.

Once changes have been made, deselect text mode by clicking in any open area of the screen, away from the plate object.
In this example, a text file was created in order to copy and paste the variables into the Vision software. Highlight the text and select copy from the edit menu (or right click and select copy). Note that in this example, the two variables are entered as subsequent lines in the text file and that there may be difficulties when importing from other file formats. A simple text file created in Windows Notepad is suggested.

To insert the copied text, select Layout → Plate Object → Paste Clipboard Into Plate.
Click in the center of the plate.

After clicking in the center of the plate, all fields are merged and multiple plate objects will be created based on the number of text variables selected.
Also, if there are more variables than can be fit into one plate in the Vision software, multiple plates (or pages) are automatically generated for individual output to the engraver. The lower right corner of the Vision software screen allows the user to view the individual pages. During the Engrave operation, the user will select the page to be sent to the engraver.

To finish this example job, set up the engraver for a metal burnishing application as described in the previous section and select the Engrave icon from the left toolbar, then click on the Tool Setup icon, chose Metals(Burnishing) as the material and click on OK. If you choose to run a Dry Run (as shown) to make sure the setup is correct, proceed as in prior sections to send the file to the engraver.

Note that if the plate objects are left as part of the file sent to the engraver, they will engrave as well. If this is not desirable, simply select the plate object within the Vision software and delete it prior to sending the file to the engraver. Alternatively, the plate object may be changed to a different color than the text to be engraved. Within the Vision software, the Engrave by Color option (discussed in the next example job) can be used to only send the text to the engraver.

In this example, the plate object lines were engraved.
4.7 Profile Cutting

In this section, we will set up to engrave with a standard engraving cutter and cut completely through engraver's plastic with a cutter/beveler. The cutter/beveler is used to create a contrast on the edge of the cut material. The figure below shows the Vision Express spindle with a rotary cutter/beveler.

Vision Express Spindle with Rotary Cutter/Beveler

First, to install the rotating cutter, loosen the set screw on the cutter knob with the supplied cutter wrench and move the cutter knob to about the mid-point of the cutter tool, then lightly tighten the set screw. Insert the cutter into the top of spindle and lower it until the cutter knob can be screwed into the spindle. Tighten the knob COUNTER-CLOCKWISE (when viewed from the top of the spindle) until it is hand tight. Then, you must zero the cutter. To do this, you must first turn the micrometer so that the pointer points to 0. Note - it is helpful to first turn the micrometer to the left (clockwise) until threads just start to appear on the spindle. This allows for sufficient depth adjustment when turning the micrometer to the right). Zero the cutter, then set the engraving depth as described in the Rotary Engraving section. You will then need to set the cutting depth of the cutter/beveler tool.

Setting Cut Depth for Cutter/Beveler Tool - Standard Method

If you have measured the thickness of the material to be cut, you can adjust the micrometer in two ways - 1) adjust the cutter to cut through the material PLUS 0.001 - 0.003 inches (0.0250 - 0.075 mm). This method will produce a clean cut of the parts and lightly cut into the sacrificial material underneath, or 2) adjust the cutter depth to cut through the material MINUS 0.001 - 0.003 inches (0.0250 - 0.075 mm). This will create a "kiss cut" that will leave a very thin amount of material which holds all of the parts together, then the parts can be snapped apart after removal from the engraver. This second method is ideal in production environments where part handling is an issue.

Alternate Method For Setting Cut Depth for Cutter/Beveler Tool - "Stacked Material Method"

As an alternate to dialing the micrometer 50 or 60 clicks to set the cut depth on 1/16th inch plastics (or up to 130 clicks for 1/8th inch material), this second method utilizes a second piece of the same kind and thickness of material to be cut to set the cut depth. Refer to the below diagram - the material to be cut is placed on top of the sacrificial material/Multi Mat materials. The material to be cut is held in place either with double sided tape or by the spray adhesive/transfer tape method detailed in the Holding Down Materials section. Then a second piece of material is placed on top of the material to be cut. The
nose cone is lowered on top of the second piece of material (near its edge) and the cutter is adjusted downward until it touches the top of the material to be cut. This, in effect, sets the cut depth to match the material thickness. The cutter knob set screw is tightened, then the micrometer is adjusted, either for a through cut (turning clockwise) or a kiss cut (turning counter-clockwise), 1 - 3 clicks.

Holding Down Material

Secure the material on the t-slot table. It is best to use Multi Mat to hold the material in place, but keep in mind that since we are cutting completely through, there will likely be cut marks into the Multi Mat when the job is complete. Another procedure is to use a piece of sacrificial material on top of the Multi Mat. DO NOT place the material to be cut directly on the t-slot table. If you do, then the cutter will cut into the t-slot table and permanently damage the surface. Other methods for holding material down are in the section Holding Down Material.
4.7.1 Example Job 4 - Profile Cutting

In this example job, engravers plastic will be set up to engrave several name badges, then the badges will be cut out. 1/16th inch standard engravers plastic is used. Two different tools will be used - one to engrave, and one to cut/bevel the edges.

As with Example Job 2, the Vacuum Chip Removal System is highly recommended for this application and is shown in this example.

First, the plate size will be adjusted to the standard Vision Express 8 x 6 inch area.

A single Plate Object will be created (from the top toolbar menu - Layout ➔ Plate Object ➔ Create Plate) with a size of 3 x 2 inches (75 x 50 mm) and margins on the top and left side will be set to 0.25 inches (6.4 mm). The margins are necessary so that during the cutting operation, the cutter will not cut right on the edge of the material, or on the edge guides.
A Clip Art image will be added to the badge. The image is GENE0038.CDL from the Vision software clip art in the General folder (installed as C:\Vision Express 9\ClipArt\GENERAL). To import the clip art, simply browse the folder in Windows Explorer and drag the file to the engraving area on the plate within the Vision software. The image will be quite large, so it must be re-sized to fit, either by changing the size manually on the toolbar, or by selecting the object and clicking on a corner node (holding down the left mouse button) and dragging the corner to make the image smaller.

For this example, the image was re-sized to 0.5 x 0.5 inches (12.7 x 12.7 mm) and located at X 0.75, Y 1.875 as shown below.
Next, three text fields are entered with the Text Compose tool. At first, when clicking in the middle of the Plate Object, the text field is set to centered within the plate and auto sized. We will adjust the text frame size and location using text Frame mode. To enable, select the Toolbar Mode Icon on the toolbar (only visible after selecting text, or after clicking on the Text Compose icon, then clicking within the plate object), then select the Frame mode. This will allow sizing and placement of the text field.

Select Frame mode.

Next, we will re-size the text area and type in some text (it does not matter what text is entered here. It is just entered to create the text object). To re-size the text frame, click and hold with the left mouse button on the black edge of the text frame and drag the frame to the appropriate size.
Two more text fields are entered in the same manner, re-sized, and fonts are changed.

At this point, we need to change the two fixed text fields to graphics, so that when we import the text file for multiple badges, the correct text is replaced. Select the two text fields shown and from the toolbar, select Arrange → Text To Graphics. HINT - to select more than one object, click on the first object, hold down the Shift Key, then click on additional objects.
The two text fields are now non-editable graphics and will not be replaced when importing a text file with variable text. Next, copy the list of text variables from a Notepad text file and select Paste Clipboard Into Plate, then click in the middle of the Plate Object.

Note that in this example, there are 6 names that were imported, so two pages are created in the Vision software.
Lastly, before we send the file to the engraver, we will separate the graphics into two different colors, one for engraving and one for cutting. This is necessary so that two files can be sent to the engraver independently and a cutting tool change can be performed after engraving. To change the Plate Object frames to another color (red in this example), select the Plate Object frame, then click on the Red color icon on the bottom toolbar of the Vision software. It is also a good idea to verify the color of the other objects on the screen. If all other objects are to be Black, then select everything except for the Plate Object frame and click on the Black color icon at the bottom of the screen. Many times, when importing graphics, the color is unknown, so making sure the graphics are the correct color is good practice.

Note that each page of the file will need to have the plate frame color changed.

After changing the plate frame color.
If you try to send this file to the engraver at this point (by clicking on the Engrave icon), a warning screen may appear as below.

![Cut Order Warning](image)

In order to engrave by color, from the toolbar menu select Engrave → Engraving Defaults (Note that the Cut Order Warning screen refers to the "Plotting Defaults", but the menu item is "Engraving Defaults"),

![Vision Express 9 - Cut and Engraved Badges 2.CDL](image)

then make sure Engrave by Color checkbox is selected, then Apply and Close.
In order to send the engrave file to the engraver, select the Engrave icon from the left toolbar, at which time the Filter by Color window will appear. Select the color to send to the engraver in the Filter Layer drop down box. In this example, all text and graphics are Black, so the color Black (P1) was selected from the drop down menu in the Filter by Color window.

After clicking on Select, the Vision software window will show only the color being sent to the engraver, in this case, black. Click on the Tool Setup icon, select Engraver’s Plastic (Engraving) for the material, and click on OK. Make sure that all options are turned on in the Cut Toolbox, including Dry Run for this example file. Select the Engrave icon from the Cut Toolbox to send the file to the engraver.

If there are multiple pages, the Page Selection screen will appear for you to choose which page(s) to send to the engraver. In this example, the Current page will be sent by itself so that the cut file can be sent afterward.
After selecting OK, the Dry Run job file is sent to the machine. Place the material on the table and make sure the engraver is set up as in Rotary Engraving section before running the file. If the Dry Run shows proper job setup, send the job to the machine with the Dry Run turned off. Use the proper cutting tool for the engraving application. After pressing Start and finishing the job, the engraved portion of the file should appear as shown.

**Cutting**

After sending the engrave file to the machine, the Filter by Color window will re-appear, signaling that the software is ready for you to send another file to the engraver. Since we need to change the material setting, select Stop Cutting.

Select the Engrave icon from the left side toolbar, then select Cancel from the Filter by Color window.
Select the Engrave icon from the left side toolbar, then select the color for cutting in the Filter Layer drop down box in the Filter by Color window (select Red for this example). The screen will show only objects in the color selected in the Filter by Color window.

Change the material setting by first clicking on the Tool Setup icon, then selecting Engravers Plastic(Cutter/Beveler) from the drop down list, then click on OK.

Then select Engrave from the Cut Toolbox to send the cut job to the machine.
The page selection screen will re-appear, for this example, choose Current Page and select OK. The file will be sent to the engraver. Make sure you have installed the cutter/beveler tool for this process and set up the cutting depth as described in the previous section.

Note - The Filter by Color screen will once again appear. Since we have no further colors to send to the engraver, select Stop Cutting.
4.8 Vectorizing Bitmaps and Creating Vector Fills

In this brief section, the commonly used techniques of importing a bitmap and vectorizing it for engraving/cutting, and the process of adding a vector fill to an outline will be demonstrated.

It is often required that a scanned image or a bitmap file is requested to be engraved. Since the Vision engraver is vector based and requires vector lines in order to follow a path for engraving, these bitmaps will need to be converted to vector images before being sent to the engraver. In many cases, the outline itself does not represent the graphic properly. The middle of the image will need to be engraved as well, and this requires a vector fill to be added to the vector image, so that the engraver can create larger/wider engraved areas.

4.8.1 Vectorizing a Bitmap in Vision Express 9 Software

The Vision Express 9 software has a new and vastly simplified method of creating a vector outline from a bitmap image. Vector outlines are automatically created when the bitmap is imported in the drawing. The following procedure can be used to import custom logos or images into the Vision Express 9 software for engraving purposes.

Compatible file types - Whether the user wishes to scan an image and import it, or will be using a file already created in another program, the image MUST be in a black and white .bmp format in order for the software to quickly create a vector outline. It is critical that the image be created at a high enough quality before creating the vector outline.

If the image has been printed and the user needs to scan it before importing it into the Vision Express 9 software, the image must be scanned at a recommended 300 dpi, then saved as a .bmp file format. Lower resolution images may not allow the software to create a good quality outline.

Open the Vision Express 9 software and create a new file in the desired plate size. Then simply select File → Import from the top toolbar menu.
Using the drop down menu for Files of type, select Vectorize bmp (*.bmp), then choose the file and select Import.

The next screen has only one adjustment - Alignment Bitmap Density. There is a slider bar for darkening or lightening the image to show more or less detail. The default slider position is recommended. Select OK and the bitmap will be automatically converted to a vector outline for engraving.
The final image is shown below after it was imported and converted to a vector outline. It is ready to cut or engrave.

4.8.2 Vector (Hatch) Fills

When an outline of an object needs to have the interior, or sections of the interior engraved, the Hatch Fill tool is used. As an example, if a simple circle is drawn in the Vision Express 9 software, but the user wants to engrave the entire circle, not just the outline, a hatch fill is used to create the vector fill path for the engraver to follow. In this section, three applications of a hatch fill will be shown.

Filling a simple object

After creating a new file in the Vision Express 9 software, draw a circle using the Circle icon from the Shape Tools flyout menu,
Click, hold and drag a circle, then select the Hatch Fill icon from the Stroke and Fill Tools flyout menu.

After selecting the Hatch Fill icon, the selected circle will be vector filled with the default settings. Note that on the top toolbar menu, tool options are now shown and the Tool width is set to 0.015 inches, Fill angle is at 0.000 degrees, the Fill style is S sweep and the color is Red. When selecting the Tool width, it is recommended that the have a 20 - 25% overlap on each stroke. To determine Tool width, the cutter tip width will determine the Tool width. If a cutter with a cutter tip width of 0.020 is being used, then the recommended overlap for the Hatch Fill would be 0.020 x 25% = 0.005 inches. To produce an overlap of 0.005 inches, subtract 0.005 from the cutter tip width (0.020 - 0.005 = 0.015 Tool width). If a cutter tip of 0.050 is used, then the overlap would be 0.050 x 25% = 0.0125 inches, so the Tool width for the Hatch Fill would be 0.050 - 0.0125 = 0.038 inches.

The user can experiment with different Fill angles and Fill styles to determine what looks best. Tool widths can be changed as well. More overlap creates a smoother background engraving, but requires more time. Less overlap will be faster, but the background can become rough. If the Tool width is greater than the cutter tip width, portions of the background will not be engraved. Doing so creates a visible hatch fill, which may be desirable for some applications.
Once the Hatch Fill has been adjusted, select Close from the toolbar menu. The image is ready to be sent to the engraver. You may want to change the hatch fill color to match the color of the outline, although it is not necessary.

Filling Outline Text

Hatch fills can be applied to outline text, but not single line text. In the below example, Arial text was used by selecting the Frame Text Compose icon and clicking in the middle of the plate to create the text as shown.
Before filling text, the user must first select the text with the Select Tools icon. Click on the Select Tools icon and select the text to apply the hatch fill to.

Select the Hatch Fill icon.
As with the previous example, the hatch fill is applied. Adjust the Tool width, Tool angle, Tool style and color as desired, then select Close. The file is ready to be sent to the engraver.

Complex Hatch Fills

Some graphics have portions that do not need to be engraved and are within the boundaries of outside vector outlines. Using the Flower example file, import the file to vectorize the bitmap, then select the Break Path icon to separate the individual outlines.
Next, we will need to create a path. The Vision Express 9 software has an intelligent path tool that will automatically detect portions of the graphic that are within outside vector lines and will create a hatch fill with the center portions left as unfilled. Press the F3 button on the computer keyboard to select all items, then select the Make Path icon.

Then click and hold on the node in the center of the graphic. The automatic detection will display the areas that can be hatch filled.
If this looks correct, select the Hatch Fill icon.

The hatch fill will be applied. Adjust the tool options as desired and select Close from the toolbar menu. The file is ready to be sent to the engraver.
4.9 Advanced Operation

The following sections are for users that have progressed through the step-by-step operation of the Vision Express and want to know how to get the most out of their engraver.

It can be challenging to correctly position text and/or graphics. Odd shaped items, which are difficult to measure or locate on the engraving table, pose the biggest problem to most users. The Vision Express has features to help with positioning items and graphics. Two of these features are Setting a Custom Home Position, and using the Jogger and Red Dot Laser Pointer together. Both of these techniques will assist the user when engraving more challenging applications.

4.9.1 Setting and Using Custom Home Positions

For some applications, it may be easier to engrave an item by setting a custom home position. Typically, the home is set to a point on your material in the upper left hand corner of the area to be engraved. An example of this is shown below using the back side of a cell phone case.

In this example, the user has identified the engraving area on an item, and the home (or 0,0) position of the machine will be set to match the upper left corner of the engraving area. Referencing the drawing above, the engraving area is 2 inches wide by 1 inch high.
In the Vision 9 software, begin by making the plate size the same as the engraving area (2 inches x 1 inch as shown below).

Add text and/or graphics: The Frame Text Compose icon will center and adjust text sizing to fit the plate/engraving area.
To set the home position of the machine to the upper left corner of the engraving area, place the material (in this example, the cell phone cover) on the engraving table and secure it. Install a cutter and set it so that the cutter tip extends below the nose cone and can easily be seen. It is best to use a cutter with a defined point when performing a job setup, such as the diamond drag cutter used here. The picture below shows a 2” x 1” piece of tape applied to the material so that it is easier to reference the corner of the engraving area and get the positioning correct.

In the Vision 9 software, select the Jogger icon from the top toolbar.

Select Connect, then use the Arrow buttons to move the spindle over your material until the cutter tip is pointing to the upper left corner of the area to be engraved.
The pictures below show the cutter tip positioned in the upper left corner of the engraving area.

To set this point as the Home Position, you must select a home position number other than 0 in the Jogger window. In this example, the home position 1 was selected. Use the drop down list next to the Set Home icon and select a Home Position number. You can set up to 7 different custom home positions. These custom home positions are stored in the machine, even if the machine is powered off.

Once the home position number is selected, click on the Set Home icon, then click on Disconnect and close the Jogger window.
When sending the job to the engraver, select the Engrave icon from the left toolbar, but before selecting Engrave from the Cut Toolbox, you MUST choose the new home position from the Tool Setup window. Select the Tool Setup options icon (which looks like three dots) from the Engrave Menu Bar, as show below.

The Tool Setup window will appear. First, select the appropriate material setting from the Material drop down list, then in the Preset Home Position field, change the home position to the number that corresponds to the home position you set in the Jogger window (in this example, home position 1). Make sure there is a check mark in the box next to the Preset Home Position field. The check mark tells the machine to use this preset. Select OK to close this window. The home position is saved with the material settings, so if you change materials, you must also change the home position for that material.

All files sent to the engraver using this material will now use Home Position 1 as the 0,0 (upper left corner) of the engraving area. When you want to return to using the default Home Position, open the Tool Setup options window (after selecting the Engrave icon from the left toolbar) and set the Preset Home Position back to 0, then click on OK.
Send the job to the engraver as a dry run to determine whether or not the job is positioned correctly. If it is, you are ready to engrave the item. If the positioning is not correct, you can either adjust the graphics within the Vision 9 software, or correct the custom home position.

Hint - It may be useful to send a dry run job to the engraver that includes a simple rectangle that is slightly smaller than the engraving area, as shown below. The Red Dot Laser Pointer will follow the path of this rectangle and outline the engraving area. This can make it much easier to see if your home position and engraving area is located properly before sending the final job to the machine.
4.9.2 Using the Red Dot Laser Pointer for Positioning

A common and easy way to position text and graphics is to use the Red Dot Laser Pointer in addition to an outline of the area to be engraved drawn in the Vision 9 software. The following example will walk the user through this process.

In this example, a 3 inch diameter piece of acrylic will be used and a circular engraving area will be designed. If you are using a rectangular item, the process will be very similar and differences are noted here detailing the variations in the job set up.

First, place the material somewhere on the table. (If using a rectangular item, make sure it is square to the table edge guides). In this example, Multimat is used to hold down the piece of acrylic. Next, install a cutter into the spindle (in this example, the diamond drag cutter is used because it has a fine point which will be used for positioning the spindle). Lower the cutter until the tip extends below the nose cone (see picture below). Open the Jogger in the Vision 9 software and move the tip of the cutter to the top edge of the piece of acrylic (using the left, right, up and down arrow buttons, as well as the Z down buttons) and write down the Y position readout in the Jogger window. As shown here, the cutter tip is pointing to the top edge of the piece of acrylic. (For rectangular items, move the cutter tip to the upper left corner of your engraving area).

The Jogger window shows a Y position of 1.642 inches for this example. Write down the number in the Y readout field, then move the spindle to the left edge of your material. In this example, the left edge is located at an X position of 2.619 inches, write the X readout number down for the left edge. Repeat moving the spindle to the right and bottom edges of your material and note their positions from the Jogger window readout. In this example, the right edge is at an X position of 5.619 inches and the bottom position is at a Y position of 4.642 inches. (For rectangular items, you can use the X and Y readouts in the Jogger window for the upper left and lower right corners of your engraving area). Disconnect from the Jogger and close the Jogger window when finished finding the X and Y locations (top, left, right and bottom edges of your engraving area).
In the Vision 9 software, we will now draw guidelines using the measurements we wrote down. To add a guideline, click with the right mouse button anywhere within the plate area. The Edit Guides window will appear. Select the horizontal guide icon in the upper left corner of this window and in the Y entry field, type in your first Y number (for this example, 1.642 was entered as shown below). Click on Add, then enter the second Y value you measured and click Add. Click on the vertical guide icon and add the X values you measured.

Click on OK when finished. You should then have four guidelines as shown here (your item's engraving area and locations will differ than those shown in this example).
Select the Shape Tools icon from the left toolbar, then select the Circle tool (or the Rectangle tool for rectangular areas).

Click, hold and drag a circle (or rectangle) of any size. When using a circle, enter the radius of the circle (1.50 for this example) in the Circle Radius field on the top toolbar. Press the Enter Key to retain this setting.

Deselect the Circle tool by clicking anywhere outside of the circle, then move the circle by clicking, holding and dragging from the center node of the circle until it snaps to the guidelines you have drawn. (If you have a rectangular area, deselect the Rectangle Tool by clicking once outside of the rectangle you have drawn, then click, hold and drag from the middle nodes of the sides of the rectangle until each side of the rectangle snaps to the appropriate guideline - the bottom line of the rectangle snaps to the bottom guideline, the top to the top, etc.)
You should see one of the two figures below.
You can now use the Text Compose tool to type in text, or import graphics, then size and locate them within the circle (or rectangle) you have drawn.

Since we are engraving on acrylic in this example, we will now mirror the text so that it will be reverse engraved. Make sure the text and/or graphics are selected, then click on the Horizontal Mirror icon on the top toolbar.
The graphics should appear as shown below.

In order to make sure the engraving will be located properly, we will send this file to the engraver as a Dry Run. The Red Dot Laser Pointer will show where the outline of the engraving area and the graphics will be engraved. If we were not accurate in measuring the X and Y positions of our engraving area with the cutter, we can now adjust the location of our engraving area by moving the graphics within the Vision 9 software, then perform another Dry Run to check for proper positioning. We may need to send several dry runs to the engraver before the positioning is correct. Once the dry run shows that the graphics and the outline of the engraving area are positioned properly, we can send only the graphics to the engraver with the dry run turned off and engrave the item.
4.9.3 Adjusting Spindle Pressure

In some cases, the pressure applied by the spindle (when engraving with the proximity sensor), will need to be adjusted. Behind the spindle, there is a Spindle Pressure Spring Adjustment knob that can be turned to increase or decrease the amount of pressure. The pictures below show the location of this knob.

![Spindle Pressure Spring Adjustment knob](image1)

![Spindle Pressure Spring Adjustment knob](image2)
To change the engraving pressure, the knob must be rotated, which changes the preload on the spring, and therefore the amount of pressure applied by the cutter tip on to your material. This is normally performed for diamond drag engraving only. More pressure will produce a deeper engraving. To increase the engraving pressure, the knob must be rotated clockwise (when viewed from the top of the machine). In order to access this knob and turn it, turn the machine off, then press on the top of the spindle to lower the spindle to its bottom position. Reach under the spindle assembly as shown. Turn the knob clockwise to increase pressure and counterclockwise to decrease pressure.
5 Maintenance

Vision strives for the highest quality in their manufacturing process to provide you with the most cost effective, reliable engraving machine in use today. Please remember that proper maintenance and care is necessary to achieve maximum product life expectancy.

The engraving environment generates small plastic and metal chips as well as other particles during operation. As with any machinery, your engraving system should be kept as clean as possible to minimize wear and tear, and to improve final quality of the engraved product.

5.1 Cleaning

Chip Removal
Plastic and metal chips generated during the engraving process should be removed from the engraving surface periodically. A portable vacuum is suggested for chip removal, but applying direct suction to the spindle area is not recommended. Note that this cleaning can be minimized and greatly simplified through the use of the optional vacuum chip removal system. The vacuum chip removal system removes chips and dust created by engraving. This system can also extend the life of other components in the system, as prompt removal of chips reduces contamination and overheating in the spindle area. The vacuum chip removal system also keeps the nose cone from skipping over letters when chips become trapped between the nose cone and the engraving material.

Cleaning The Nose Cone
The nose cone around the cutter may accumulate dust and chips that cannot be removed by vacuuming or blowing on them with low pressure air. CAUTION! High pressure air can damage the spindle. Two types of nose cones are available; one nose cone is designed to be used with the vacuum system, the other is not. Cleaning methods depend on the type of nose cone in use.

With a vacuum chip removal system, most of the chips will be removed during the engraving process. If the suction nozzle becomes clogged, remove the hose connection to the nose cone. Remove the cutter, then unscrew the vacuum nose cone. Using a vacuum or an air hose, clean out the nose and the vacuum tube leading to the nose cone. Reinstall the nose cone and the vacuum hose.

Without a vacuum chip removal system you should remove the cutter before attempting to clean the nose cone. The nose cone retainer ring, the nose cone, and the micrometer collar should all be removed and cleaned using a vacuum or compressed air. The three nose cone components should be removed and cleaned at least every day, or as frequently as necessary. Failure to clean the nose cone regularly will result in premature spindle failure.

Cleaning the Vacuum Filter (only with the vacuum chip removal option)
On systems with a vacuum chip removal system, frequent cleaning of the vacuum filter is necessary for proper performance. When engraving with the vacuum filter system, the filter should be checked and cleaned several times a day, depending on the amount of engraving performed. If the vacuum does not appear to be functioning efficiently, clean the filter more frequently.

To clean the vacuum filter system, disconnect the vacuum hose from the canister. Loosen the three wing nuts on top of the canister enough to allow the attached bolts to swing away from the lid, then remove the lid. Do not completely remove the wing nuts. There are two filters inside the canister. Carefully remove the inner, paper filter. (The paper and cloth filters tend to stick together). Empty the paper filter, and shake it out completely, being careful not to damage it as the filters are reusable. After shaking out the paper filter remove and empty the cloth filter in the same manner as the paper filter. Do not wash either filter. Place the paper filter back inside the cloth filter, and place the cloth filter back inside the vacuum canister.
5.2 **Lubrication**

**Materials Needed**

- 3-in-1 oil
- Teflon-free Silicon Spray
- Allen Wrench Set
- Paper Towels
- Isopropyl Alcohol

**Procedure**

Portions of this procedure are illustrated with the top cover installed. Although it is not necessary to remove the cover for cleaning and lubrication, it will make access to the various motion system components much easier.

**Spindle Cover Removal**

To remove the spindle cover, slide the cover up. Squeezing the sides of the cover will facilitate removal.
Top Cover Removal

Power off the machine, remove the power cable and network plug from the rear of the machine. Remove the 2 Allen Screws on the left side and 2 on the right side of the top cover. Slide the top cover up and back to remove it from the machine.

HINT: Pressing outward on the inside walls of the machine's frame may facilitate in cover removal.
Cleaning

NOTE - With the machine POWERED OFF, you can move the carriage, table and spindle manually to access areas for cleaning and lubricating the machine. To move the table, press on the front or rear edge. To move the carriage, press on the left or right side of the carriage cover. To move the Spindle, press on the top of the Spindle to move the Spindle down and press on the bottom of the Spindle to move it up.
Apply isopropyl alcohol to a paper towel and wipe down the X-Axis (carriage) leadscrew and the stainless steel rail for the carriage. Move the carriage and spindle to access all areas of the leadscrew and rail.

Apply isopropyl alcohol to a paper towel and wipe down the leadscrew and the stainless steel rail for the t-slot table.  
NOTE: Clean the leadscrew, rail and baseplate (the area underneath the table) with the table in the fully extended (forward) and fully retracted positions.
Lower the spindle down to access the upper sections of the spindle rail. The rail is located behind the spindle. Apply isopropyl alcohol to a paper towel and wipe down the sides and front of the spindle rail. Then raise the spindle and wipe down the lower portions of the spindle rail.
NOTE - The Z-Axis leadscrew is protected from debris by the carriage cover and is less likely to become contaminated by debris. It will require periodic cleaning and lubrication. To access the Z-Axis leadscrew, remove the top cover and the carriage cover, then lower the spindle. This will expose the leadscrew, which is located between the spindle and the motor.
In the below picture showing the Z-Axis leadscrew, both the top cover and the carriage cover have been removed.
**Lubrication**

**X&Y-Axis Linear Rails**

Apply 2-3 drops of a light oil (such as 3-in-1 oil) on the rails and spread it evenly with your fingers.

**X-Y-Z-Axis lead screws**

A light lubrication of the X, Y and Z-Axis leadscrews should be performed periodically. At a minimum, lubrication should be performed every 6 months, although if applications that produce large amounts of debris are run (such as wood or plastic engraving), cleaning and lubrication should be performed more often. Use Teflon-free silicone lubricant only on the leadscrews. **DO NOT** use any lubricant other than Teflon-free silicone spray, as it may attract debris and create a buildup that can cause mechanical failure.

**NOTE:** Place a paper towel underneath the leadscrews to prevent over spray as shown below.

---

![Image of a machine with lubrication in progress](image)

**Working in the lubricants**

After completing this procedure and re-installing the carriage and top covers, the lubricants should be worked in to the motion system for several minutes prior to using the machine. To move the motion system, use the Jogger function from the Vision software, moving the carriage, table and spindle through their range of motion to evenly distribute the oil.

**What not to lubricate**

Many of the bearings and assemblies in your engraving machine are sealed and/or coated using special low-friction methods and should not be lubricated.

**DO NOT** attempt to lubricate the spindle or the spindle bearings. This will attract particles and dust, which will build up between the shaft and sleeve and possibly prevent movement. If you suspect lubrication problems, call your dealer/representative or the service department at Vision.

**DO NOT** oil the X or Y stepper motors. None of the motors on the Vision Express require lubrication. Oiling the stepper motors can permanently damage them.

**DO NOT** use any type of grease product to lubricate this machine.
5.3 **Changing the Motor Belt**

In order to change the motor belt, it is recommended to remove the spindle cover, top cover and the carriage cover. Power off the machine, slide the spindle cover up and remove. Remove the top cover screws and top cover, then remove the carriage cover screws and carriage cover.
To remove the motor belt, roll the front edge of the belt up and over the top of the spindle.

To install the new belt, position the belt in the groove of the motor pulley and pull the belt toward the top of the spindle. It will help to pull the belt forward and roll the front portion of the belt downward when stretching it over the top of the spindle. Once the belt is in place, rotate the spindle by hand a few times to check for binding and to make sure the belt is properly installed. Re-install the covers.
5.4 Changing the Motor Brushes

Motor brushes are a wear item on the engraver and will eventually require replacement. Motor brushes experience wear during rotary engraving or cutting operations. The life of the motor brushes will depend on the usage of the machine and they will typically last for several years.

NOTE - Unplug the machine from its power source before attempting this procedure. Failure to unplug the machine could present an electrical shock hazard.

To easily access the motor brushes for removal, it is recommended to remove the top cover and carriage cover as described in the previous section.

Use a flat blade screwdriver to loosen the motor brush caps. Inspect the motor brush for length. If the length is under 1/8th inch (3.2 mm), the motor brush needs to be replaced.

Install the new brush into the motor housing, replace the caps and machine covers.
6 Optional Accessories

6.1 Vacuum Chip Removal System

The process of engraving or cutting plastics, acrylics, sign foam and wood, produce a significant amount of debris that can clog the nose cone and/or get trapped between the nose cone and the material, which will cause engraving/cutting depth inconsistencies as well as potentially scratch the surface of the material. The vacuum chip removal system is designed to simplify the engraving process and minimize wear and tear on the engraver. It uses a vacuum nose cone to remove chips created during the engraving process before they have the chance to create problems. The quiet pump, coupled with the microfine-layered filters assures that your unwanted chips are whisked away effortlessly. The vacuum pump canister uses replaceable/reusable filters to assure maximum efficiency and cost-effectiveness.

The system allows prompt removal of chips and dust created in the engraving process, reducing contamination and overheating in the spindle area. Chip removal also prevents the cutter from skipping over letters due to stray particles. This vacuum chip removal system is available with or without a Vision vacuum nose cone.

The Optional Vacuum Chip Removal System
6.2 Quick Lock Vise

The Quick Lock Vise is used to clamp rigid materials against the top Edge Guide in order to prevent movement. This is an alternate method for holding down materials.

Put the material you would like to engrave on the t-slot table and push it to the home position corner. Next, loosen the quick lock vise locking screw and slide the quick lock vise so that there is about 1/16th inch gap between the edge of the vise and the material. Tighten the quick lock vise locking screw. Once this is done, the material can easily be secured by turning the quick lock vise handle. When changing the engraving material, simply loosen the quick lock vise handle, remove the engraved material, put the new material in and tighten up the quick lock handle.

Note: For larger pieces of material, you may need to put a small piece of double-sided tape on the t-slot table in the middle of the engraving material. This will keep the material from bowing in the center.

The quick lock vise will only work on square or rectangular material. To hold down irregular shaped objects, you must use some other method. Ask your Vision Distributor or Vision if you need more information on this feature.